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AHB Advanced High Performance Bus FtERE 2
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DDR Double Data Rate Memory KGR 2R ATAd 2
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DMAC Direct Memory Access Controller IER R etk
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® 3-1 L ARGHHE
R4 FHIE
MCU Core 5-stage in-order execution pipeline

Frequency: Max. 800MHz

Hardware multiplier
radix-2/radix-4/radix-14/radix-256/fast

Hardware divider

Optional branch prediction

4-entry return address stack (RAS)

Static branch prediction

Dynamic branch prediction
32/64/128/256-entry branch target buffer (BTB)
256-entry branch history

8-bit global branch history

Machine mode, Supervisor mode and User mode

Optional performance monitors

Misaligned memory access

RISC-V physical memory protection

ISA

RISC-V RV32I base integer instruction set

RISC-V "C" standard extension for compressed instructions

RISC-V "M" standard extension for integer multiplication and
division

RISC-V "A" standard extension for atomic instructions

MUG1031-1.1
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RISC-V "N" standard extension for user-level interrupt and
exception handling

RISC-V "F" and "D" standard extensions for single/double-
precision floating-point

DSP supported

Privilege

Machine, Supervisor and User privilege mode

Page-based virtual memory, supervisor mode and SV32 virtual
address translation scheme

128 number of shared Translation Lookaside Buffer (TLB) entries

8 number of instruction TLB entries

8 number of data TLB entries

16 number of support physical memory protection entries

Hardware performance monitors

Vectored PLIC extension

Hardware stack protection extension

Hardware performance throttling mechanism extension

Power
Management

Wait-for-interrupt (WFI) mode

Debug

RISC-V extend debug support

Number of breakpoints: 8

External JTAG debug transport module
JTAG: IEEE STD 1149.1 style 4-wire JTAG interface
Serial: 2-wire serial debug interface

PLIC

Configurable number of interrupts: 1-1023

Number of interrupt priorities: 15

Configurable number of targets: 1-16

Vectored interrupt extension

Support software interrupts

Support 16 user interrupts

PLMT

The RISC-V architecture defines a machine timer that provides a
real time counter and generates timer interrupts

Cache

I-Cache

Size: 32KB

Associativity: 4-way
Replacement policy: pseudo-LRU

6(48)
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3.2 RS

RG AL

Soft error protection

: single/double error correction

D-Cache

Size: 32KB
Associativity: 4-way
Replacement policy
Soft error protection

: pseudo-LRU
: single/double error detection

Local Memory | ILM
Base: 0xA0000000
Size: 64KB

Soft error protection
detection

: single error correction and double error

DLM
Base: 0xA0200000
Size: 64KB

Soft error protection
detection

: single error correction and double error

Slave port support

3.2 HFiiksr RS

FEA# A% R ARAE AR 3-2 .

MUG1031-1.1
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R4 AL

Instruction Memory | Address: 0x8

0000000~0x8FFFFFFF

Size: Max. 256MB

Bus: AHB bus interface

Embedded: SPI Flash Memory

Frequency: Max. 200MHz

Data Memory Address: 0x0

0000000~0x7FFFFFFF

Size: Max. 2GB

Bus: AHB bus interface

Embedded: DDR3 Memory

Frequency: Max. 200MHz

7(48)




3 RYURHLE

3.3 MAHMNBARG

3.3 BLIMERSE

B EAN R R G RIFFIE IR 3-3 R .
& 3-3 BEIMERGHHE
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SMU

SMU controls the flow of power and clock changes

UART1

The UART controller handles communications to the UART
interface.

Compatible with the 16C550A register structure
Support of the hardware flow control (CTS/RTS)
Support of hardware handshaking to the DMA controller
Option of by-8 or by-16 over-sampling frequency
Support of 64-entry transmit/receive FIFO depth

UART2

The UART controller handles communications to the UART
interface.

Compatible with the 16C550A register structure
Support of the hardware flow control (CTS/RTS)
Support of hardware handshaking to the DMA controller
Option of by-8 or by-16 over-sampling frequency
Support of 64-entry transmit/receive FIFO depth

PIT

The PIT controller is a set of compact multi-function timers, which
can be used as PWM or simple timers. Each multi-function timer
provides the following 6 usage scenarios:

One 32-bit timer

Two 16-bit timers

Four 8-bit timers

One 16-bit PWM

One 16-bit timer and one 8-bit PWM
Two 8-bit timers and one 8-bit PWM

WDT

The WDT controller prevents the system from hanging if software is
trapped in a deadlock condition.

Internal/external clock source selection

Separate timers for the watchdog interrupt and the system reset
Eight choices of watchdog timer intervals

Four choices of reset timer intervals

Register write protection for watchdog timer control register and
restart register

Configurable magic number for register write protection

MUG1031-1.1
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Configurable magic number to restart the watchdog timer

RTC

RTC keeps track of current time relative to a base time. The time is
stored in a RTC counter which records the amount of elapsed time
since RTC is enabled.

The frequency of clock source (before the clock divider) for the
counter is 32.768KHz

Separate second, minute, hour and day counters

Periodic interrupts: half-second, second, minute, hour and day
interrupts

Programmable alarm interrupt with specified second, minute and
hour values

GPIO

The GPIO controller supports up to 32 channels with independently
programmable input/output control.

Support of up to 32 GPIO channels
Independent control of each channel
Programmable 1/O direction

Optional pull-up/down control

Optional support of interrupt trigger control

Flexible combination of interrupt trigger modes: high/low level
trigger and rising/falling/both edge trigger

Optional de-bounce functionality for input channels

12C

The 12C controller handles communications to 12C interface.
Programmable to be either a master or a slave device
Programmable clock/data timing

Support of the 12C-bus Standard-mode (100 kb/s), Fast-mode (400
kb/s) and Fast-mode plus (1 Mb/s)

Support of hardware handshaking to the DMA controller

Support of the master-transmit, master-receive, slave-transmit and
slave-receive modes

Support of the multi-master mode
Support of 7-bit and 10-bit addressing modes
Support of general call addressing mode

Support of auto clock stretch

SPI

The SPI controller handles communications to the SPI. The
supported serial data formats range from 4 bits to 32 bits in length.

Compliant with AMBA 2 AHB protocol specification
Compliant with AMBA 3 APB protocol specification
Support of MSB/LSB first transfer

Support of DMA data transfer

9(48)
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Support of programmable SP1 SCLK

Support of memory-mapped access (read-only) through AHB bus or
EILM bus

Support of SPI slave mode

Quad I/O SPI interfaces

TX/RX FIFO depth is128

Programming port location on APB interfaces

DMAC

The DMAC enhances system performance by transferring large
data blocks between devices in background to offload the
processor.

Compliant with AMBA AXI4 and APB4
Support of up to 8 DMA channels

Support of up to 16 DMA request/acknowledge pairs for hardware
handshake, 7 internal used, 8 for user

Support of up to two AXI master ports for data transfers
Support of up to two configurable DMA cores

Support of an APB slave port for DMA register programming
Support of 24—64 bits AXI address width

Support of 32/64/128/256 bits AXI data width

Support of narrow transfers on the AXI bus

Support of group round-robin arbitration scheme with 2 priority
levels

Support of chain transfers

Extended
APB Slave

For user to extend APB interface peripherals.
32-bit data bit width

Size: 64MB

AE350 is as master

Extended
AHB Slave

For user to extend AHB interface peripherals.
32-bit data bit width

Size: 128MB

AE350 is as master

Extended
AHB Master

For slave port support, assess local memory via master.
64-bit data bit width
AE350 is as slave

10(48)
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ARG I e g ik
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Gowin RiscV_AE350_SOC ) Embedded Data Memory (DDR3
Memory) HIREF a1k 4-2 Fiw.

+ 4-2 NTER
Speainge iNEEFES ik
DDR3_MEMORY_CLK 400/200MHz I 74 N DDR3 kL T 1 i
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4 ZGiTtRe
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Dhrystone 1.72 DMIPS/MHz
CoreMark 3.224841 CoreMark/MHz
Whetstone 0.783 MWIPS/MHz
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Gowin RiscV_AE350_SOC 1 &4t H 4ngk 5-1 Fizr.

+® 5-1 RGeiw 0
e /0 hrge | ik JiJ&
POR_RSTN input |1 Power on reset -
HW_RSTN input |1 Hardware reset -
CORE_CLK input | 1 Core clock -
DDR_CLK input | 1 Data memory clock -
AHB_CLK input 1 AHB or instruction -
memory clock
APB_CLK input |1 APB clock -
RTC_CLK input | 1 RTC clock RTC
TCK_IN input |1 JTAG clock Debug
TMS_IN input | 1 JTAG tms Subsystem
TRST_IN input | 1 JTAG trst
TDL_IN input | 1 JTAG tdi
TDO_OUT output | 1 JTAG tdo
TDO_OE output | 1 JTAG tdo oe
FLASH_SPI_CSN inout |1 Flash chip select n Embedded
FLASH_SPI_MISO inout | 1 Flash masterin and | Instruction
slave out Memory
FLASH_SPI_MOSI inout |1 Flash master out and
slave in
FLASH_SPI_CLK inout |1 Flash clock
FLASH_SPI_HOLDN inout |1 Flash hold n
FLASH_SPI_WPN inout |1 Flash write protection
n
FR_PCLK input |1 Flash register APB Embedded

13(48)
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clock Instruction
FR_PRESETN input | 1 Flash register APB Memory and
reset n Flash Register
R/W Mode
FR_PADDR input | [31:0] | Flash register APB
address
FR_PENABLE input | 1 Flash register APB
enable
FR_PRDATA output | [31:0] | Flash register APB
read data
FR_PREADY output | 1 Flash register APB
ready out
FR_PSEL input |1 Flash register APB
select
FR_PWDATA input | [31:0] | Flash register APB
write data
FR_PWRITE input |1 Flash register APB
write enable
ROM_HADDR output | [31:0] | ROM AHB address Extended
ROM_HRDATA input | [31:0] | ROM AHB read data | Instruction
Memory
ROM_HREADY input |1 ROM AHB ready in
ROM_HRESP input |1 ROM AHB response
ROM_HTRANS output | [1:0] | ROM AHB
transmission type
ROM_HWRITE output | 1 ROM AHB write enable
ROM_HCLK output | 1 ROM AHB clock
ROM_HRSTN output | 1 ROM AHB reset n
DDR3_MEMORY_CLK | input |1 DDR3 memory clock Embedded
DDR3_CLK_IN input | 1 DDR3 input clock Data Memory
DDR3_RSTN input |1 DDR3 reset
DDR3_LOCK input | 1 DDR3 lock
DDR3_STOP output | 1 DDRa3 stop
DDR3_INIT output | 1 DDRa initialized flag
DDR3_BANK output | [2:0] | DDR3 bank address
DDR3_CS_N output | 1 DDR3 chip select
DDR3_RAS_N output | 1 DDR3 row address

select

14(48)
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DDR3_CAS_N output | 1 DDR3 column address

select
DDR3 WE_N output | 1 DDR3 write enable
DDR3_CK output | 1 DDR3 clock
DDR3_CK_N output | 1 DDRa3 clock differential
DDR3_CKE output | 1 DDRa3 clock enable
DDR3 RESET N output | 1 DDRa3 reset
DDR3_ODT output | 1 DDR3 on-die

termination
DDR3_ADDR output | [13:0] | DDR3 address
DDR3_DM output | [1:0] | DDR3 data mask
DDR3_DQ inout | [15:0] | DDRS3 data
DDR3_DQS inout | [1:0] | DDRS3 data select
DDR3_DQS_N inout | [1:0] | DDRS3 data select

differential
DDR_HADDR output | [31:0] | DDR AHB address Extended
DDR_HBURST output | [2:0] | DDR AHB burst Data Memory
DDR_HPROT output | [3:0] | DDR AHB protection
DDR_HRDATA input | [63:0] | DDR AHB read data
DDR_HREADY input |1 DDR AHB ready in
DDR_HRESP input |1 DDR AHB response
DDR_HSIZE output | [2:0] | DDR AHB size
DDR_HTRANS output | [1:0] | DDRAHB

transmission type
DDR_HWDATA output | [63:0] | DDR AHB write data
DDR_HWRITE output | 1 DDR AHB write enable
DDR_HCLK output | 1 DDR AHB clock
DDR_HRSTN output | 1 DDR AHB reset n
EXT_INT input | [15:0] | Extended interrupts PLIC
APB_PADDR output | [31:0] | APB slave address Extended APB
APB_PENABLE output | 1 APB slave enable slave
APB_PRDATA input | [31:0] | APB slave read data
APB_PREADY input |1 APB slave ready in
APB_PSEL output | 1 APB slave select
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APB_PWDATA output | [31:0] | APB slave write data
APB PWRITE output | 1 APB slave write enable
APB_PSLVERR input |1 APB slave error

response
APB_PPROT output | [2:0] | APB slave protection
APB_PSTRB output | [3:0] | APB slave write strobe
APB_PCLK output | 1 APB slave clock
APB_PRSTN output | 1 APB slave reset n
EXTS_HRDATA input | [31:0] | AHB slave read data Extended AHB
EXTS_HREADYIN input | 1 AHB slave ready in slave
EXTS_HRESP input |1 AHB slave response
EXTS_HADDR output | [31:0] | AHB slave address
EXTS_HBURST output | [2:0] | AHB slave burst
EXTS_HPROT output | [3:0] | AHB slave protection
EXTS_HSEL output | 1 AHB slave select
EXTS_HSIZE output | [2:0] | AHB slave size
EXTS_HTRANS output | [1:0] | AHB slave

transmission type
EXTS_HWDATA output | [31:0] | AHB slave write data
EXTS_HWRITE output | 1 AHB slave write

enable
EXTS_HCLK output | 1 AHB slave clock
EXTS_HRSTN output | 1 AHB slave reset n
EXTM_HADDR input | [31:0] | AHB master address Extended AHB
EXTM_HBURST input | [2:0] | AHB master burst master
EXTM_HPROT input | [3:0] | AHB master protection
EXTM_HREADY input |1 AHB master ready in
EXTM_HSEL input |1 AHB master select
EXTM_HSIZE input | [2:0] | AHB master size
EXTM_HTRANS input | [1:0] | AHB master

transmission type
EXTM_HWDATA input | [63:0] | AHB master write data
EXTM_HWRITE input |1 AHB master write

enable
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E /0 hrgs | fik It
EXTM_HRDATA output | [63:0] | AHB master read data
EXTM_HREADYOUT | output | 1 AHB master ready out
EXTM_HRESP output | 1 AHB master response
DMA_REQ input | [7:0] | DMA requests DMA
DMA_ACK output | [7:0] | DMA acknowledges
SPI_HOLDN _IN input |1 SPl hold nin SPI and non-
SPILWPN_IN input | 1 SPI write protectionn | /O ports
in
SPI_CLK_IN input |1 SPI clock in
SPI_CSN_IN input |1 SPI chip select n in
SPI_MISO_IN input | 1 SPI miso in
SPI_MOSI_IN input | 1 SPI mosi in
SPI_HOLDN_OUT output | 1 SPI hold n out
SPI_HOLDN_OE output | 1 SPI hold n oe
SPI_WPN_OUT output | 1 SPI write protection n
out
SPI_WPN_OE output | 1 SPI write protection n
oe
SPI_CLK_OUT output | 1 SPI clock out
SPI_CLK_OE output | 1 SPI clock oe
SPI_CSN_OUT output | 1 SPI chip select n out
SPI_CSN_OE output | 1 SPI chip select n oe
SPI_MISO_OUT output | 1 SPI miso out
SPI_MISO_OE output | 1 SPI miso oe
SPI_MOSI_OUT output | 1 SPI mosi out
SPI_MOSI_OE output | 1 SPI mosi oe
SPI_HOLDN inout |1 SPI hold n SPland I/O
SPI_WPN inout | 1 SPI write protection n | POrts
SPI_CLK inout | 1 SPI clock
SPI_CSN inout | 1 SPI chip selectn
SPI_MISO inout |1 SPI master in and
slave out
SPI_MOSI inout | 1 SPI master out and

slave in
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[2C_SCL_IN input |1 I12C clock in I2C and non-
I2C_SDA_IN input | 1 I2C data in /O ports
[2C_SCL_OUT output | 1 12C clock out
12C_SDA_OUT output | 1 I12C data out
12C_SCL inout | 1 12C clock I2C and I/O
I2C_SDA inout | 1 12C data ports
UART1_TXD output | 1 UART1 transmits data | UART1
UART1_RTSN output | 1 UART1 rts n
UART1_RXD input | 1 UART1 receives data
UART1_CTSN input | 1 UART1 cts n
UART1_DSRN input | 1 UART1 dsrn
UART1_DCDN input |1 UART1 dcd n
UART1_RIN input |1 UART1 rin
UART1_DTRN output | 1 UART1 dtrn
UART1_OUT1IN output | 1 UART1 out1 n
UART1_OUT2N output | 1 UART1 out2 n
UART2_TXD output | 1 UART2 transmits data | UART2
UART2_RTSN output | 1 UART2 rts n
UART2_RXD input |1 UART2 receives data
UART2_CTSN input |1 UART2 cts n
UART2_DSRN input |1 UART2 dsrn
UART2_DCDN input | 1 UART2 dcd n
UART2_RIN input | 1 UART2 rin
UART2_DTRN output | 1 UART2 dtr n
UART2_OUT1N output | 1 UART2 out1 n
UART2_OUT2N output | 1 UART2 out2 n
CHO_PWM output | 1 PWM channel 0 output | PWM
CHO_PWMOE output | 1 PWM channel 0 output

enable
CH1_PWM output | 1 PWM channel 1 output
CH1_PWMOE output | 1 PWM channel 1 output

enable
CH2_PWM output | 1 PWM channel 2 output
CH2_PWMOE output | 1 PWM channel 2 output
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E 110 frge | fik Jit)&

enable
CH3 PWM output | 1 PWM channel 3 output
CH3_PWMOE output | 1 PWM channel 3 output

enable
GPIO_IN input | [31:0] | GPIO in GPIO and
GPIO_OE output | [31:0] | GPIO output enable | "on-1/O ports
GPIO_OUT output | [31:0] | GPIO output
GPIO inout | [31:0] | GPIO GPIO and I/O0

ports

COREO_WFI_MODE output | 1 Core WFI mode status | SMU
RTC_WAKEUP output | 1 RTC wakeup status
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(P

Gowin RiscV_AE350_SOC I K& & in#k 6-1 Fizr.

% 6-1 RGEE

i L A T BN Yi ]

Enable Extended Interrupts K] T M 16 MM E 5

Embedded Instruction Memory | J1 )3 RGN B IR A% 4% SPI Flash
Memory

Flash Register R/W Mode eS| JFJ5 Flash 27 #7220 APB sl 4%
|

Extended Instruction Memory | 5] ROV RINEIR A

Embedded Data Memory g RENEHIE7%%: DDR3 Memory

Extended Data Memory K] ROV RN EHAR A1

Enable Extended AHB Slave K JFia ¥ FE 1 32-bit AHB Slave 11,
AE350 17y Master

Enable Extended AHB Master | 5[] TRy R 64-bit AHB Master #2111,
AE350 £/ Slave %

Enable Extended DMAC KM TEIa 4 JE ) 8 41 DMA E5R/IN &5 5

Enable 12C KM JFA 12C

Enable 12C 1/O Ports VANE FFJa 12C “INOUT” 2875 [

Enable PIT * FE PIT

PWM Channel 0 KM FF 5 PWM J&@iE 0

PWM Channel 1 FK M I 5 PWM JiiE 1

PWM Channel 2 K] TFE PWM @i 2

PWM Channel 3 K] JFiE PWM i#iE 3

Enable SPI KM JFE SPI

Enable SPI /O Ports NG JFJE SPI “INOUT” A3 1

Enable UART1 KMl 5 UART1

Enable UART2 K H] A UART2
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i & 12 15 NN Yi ]

Enable GPIO FKH] JFE GPIO

Enable GPIO I/O Ports A A GPIO “INOUT” A
Enable WDT K /5 WDT

Enable RTC e JF)E RTC

Enable SMU FKH] JFJE SMU

Enable Extended APB Slave K FFEd I 32-bit APB Slave #11,

AE350 {E°A Master
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7 WitinAE 7.1 TEAEHR

WiRE
7.1 B

® DK-START-GW5AT138 V2.0
-  GW5AST-LV138FPG676AES
-  GWb5AST-138B

® DK-START-GW5AT138 V2.1
-  GWS5AST-LV138FPG676AES
-  GWb5AST-138B

® Tang-MEGA-138K-Pro-Dock
-  GW5AST-LV138FPG676AES
-  GWb5AST-138B

7.2 B A

ORI A =R T Gowin_V1.9.9 (64-bit).
7.3 WitHKiE

RiscV_AE350 SOC IP & itiife, 1 Fs:
1. Bzl EOB AR IP ¥ T E “IP Core Generator”, ftE
RiscV_AE350 SOC IP i&%i, 7=’k RiscV_AE350 SOC IP it

2. {E=VRHAER) IP ¥t T A “IP Core Generator” 1, FtE PLL_ADV
IP &3, 74 PLL_ADV IP ¥#it, N RiscV_AE350_SOC IP &t #h

3. M, Se#ilik RiscV_AE350 SOC IP, s:fil{k PLL_ADV IP, i
ANHABH PR, RSB e B TR Wt

4. ZWPTRFFR, IR, AT RS =8 3 A B 20 R T A
FloorPlanner;

5. ZMEAFR 7k, IR PZIH, W] UM YR AR I £ R
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T A Timing Constraints Editor;
Bo B L5 BT, AT Jay AT 42 18 TRUM AT AT 126 101 5

15 = VR AR 24 T B. GowinSynthesis®%: & RiscV_AE350 SOC fi#
PRBETE,  FEAE R SO

8 2 IR A AT JR A 48 T B Place & Route, fiiJiiAT&k MR 4, 7=
ARG S

15 =R EAE ) T 3 T H Programmer, R &A%k SCF.
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81¥2H1i§ti+7’5525
8.1 By T2

$E1

WA ATH =R, % L8 “File > New... > FPGA Design
Project”, (T HAZ “L1”, 8{ “Quick Start” ##25F “New Project...”,
o “OK”, Wi 8-1 iR

8-1 New Project

9 -8 %
DEEE & i
Recent Projects:
Quick Start
== E= E=
W New ? x
N

v Projects
Teol 2% FPGA Design Project

| |Create a FPGA design project. L
You will be able to add or create RTL sources, run synthesis,
place & route, and program your device.

! Cance

Start Page [x]

B2
WE TRV TS, Bidi “Next”, WKl 8-2 frr.
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[&] 8-2 Project Name

W Project Wizard X

Project Name
E» Project Name
Select Device Enter a name for your project, and specify a directory where the project will be stored. The directory will be

. created if it doesn't exist.
Summary

MName: |ae$50_demo |

Create in: |C:\Users\\iukai\Desktop |

[] Use as default project location

ext = Cancel

H5% 3

WHEBMEE, 45 Series. Device. Device Version. Package-
Speed #1 Part Number, .7 “Next”, #1 8-3 Fizn.

(ZLUE

Series: GWSAST

Device: GW5AST-138

Device Version: B

Package: FCPBGAG76A

Speed: ES

Part Number: GW5AST-LV138FPG676AES
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8.2 IP #it

& 8-3 Select Device

W Project Wizard x

Select Device
Project Name

E» Select Device Specify a target device for your project
Summary Filter
Series: GWSAST ¥ | Package: |FCPBGAB76A -
Device: GWSAST-138 v | Speed: ES -
Device Version: B -

#no version number is initial version

Part Number Device Device Version Package Speed  Voltage

(GWSAST-LV138FPGG76AES |awsast13s |8 [Fcpeaacres

= Back ext = Cancel

=

B4
e ARG, By “Finish”, WK 8-4 Fis.
8-4 Summary

W Project Wizard X

Summary
Project Name

Select Device Project
Eb STy N?me: ae358_demo . .
Directory: C:\Users\liukai\Desktop
Source Directory: C:\Users\liukai\Desktop\ae35@_demo\src
Implementation Directory: C:WUsersi\liukai\Desktop\ae358_demoiimpl

Device
Part Number: GWSAST-LV13BFPGE7BAES
Series: GWSAST
Device: GWSAST-138B
Package: FCPBGAGTBA
Speed: ES

= Back Cancel

8.2 IP it

MUG1031-1.1

TIREAER IP &1t T2 “IP Core Generator”, &
RiscV_AE350_SOC #%%, /£ RiscV_AE350_SOC IP.

IR Th IR SE 8 “Tools > IP Core Generator”, B{ T EL#*
“d87”, $T7F IP Core Generator, %+ “Soft IP Core > Microprocessor
System > Hard-Core-MCU > RiscV AE350 SOC 1.17, #& 8-5 7.
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& 8-5 IP Core Generator

{{ GOWIN FPGA Designer - [IP Core Generator] - o X

4 Ele Edit Project Tools Window Help -8x

. o 2n o
DERSE rx:0 B &
Design B X Target Device: |GWSAST-LV138FPGE76AES

v 7 22350 demo - [CAUsers\liukal\D...

Filter | =
[] GWSAST-LV138FPGE76AES = .
Neme vorsi RiscV AE350 SOC
> User Flash
~ [ SoftIP Core
> o Information
> BackGround Configuration
> DSP and Mathematics Type: RiscV AE350 SOC
> BB Interface and Interconnect Vendor: GOWIN Semiconductor
> Memory Control
v | Microprocessor System
> P Bus Bridge Summary
~ [ Hard-Core-MCU
& Gowin EMPUGWINS-4C) RiscV AE350 SOC platform integrates A25 Core, a 32bit CPU base
& RiscV AE350 SOC 11 on RISC-V. There are UARTO, UART1, SPI, 12C, PIT, 32bit GPIO,
> Soft-Core-MCU DMA, WDT, RTC and SMU peripherals integrated in this platform.
> Multimedia Extended AHB master and slave interface and APB interface can be
a - Serdec E) v used by user to define their own SOC system. -
Design  Process  Hierarchy 4 Start Page [ x] Design Summary B & IP Core Generator [x]
Console B x

%

Console  Message

Mt “RiscV AE350 SOC 1.17, #TJF RiscV_AE350_SOC IP Core,
ﬁ[] @ 8'6 FEZT_\‘O

&l 8-6 RiscV_AE350 SOC IP Core

{Ar RiscV AE350 SOC ? X
General
Device: ‘ GWSAST-138 | Device Version: |B |

Part Number: | GWSAST-LV138FPG676AES |

Create In: ‘ Ch\Users\liukaiDesktoplae350 demo'\src\riscv_ae350 soc | EI
File Name: riscv_ae350_soc Module Name: RiscV_AE350 SOC Top
Language: ‘Verilog -
~
AE350Subsystem
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8.2 IP it

8.2.1 PLIC

RiscV_AE350_SOC "L & [ &4 e tw#E PLIC. Instruction
Memory. Data Memory. 12C. PIT. SPI. UART1. UART2. GPIO.
WDT. RTC. SMU. DMAC. Extended APB Slave. Extended AHB Slave
F1 Extended AHB Master, Bt B EDianE 6-1 Frifid.

PUR 2 W PR B R D REATIE T AC & 7 1%

M4 H “PLIC”, BE “PLIC” &I, #nl 8-7 Fizs.

R %k “Enable Extended Interrupts”, TJF A4 R 16 AN ok
WrfE5, BRIAKEH.

Extended Interrupts [I5UES N, ESMRER TR
“Extended_Interrupts”.

8-7 PLIC it B

w PLIC 7 X

PLIC o

module of RiscV AE350 SOC is for user level ~
extended interrupts, including configurable
interrupt trigger types, software programmable
interrupt generation, preemptive priority

cons oL interrupt extension and vectored interrupt
extension.

I If users enable the extended interrupts, it
could export 16 extended interrupt signals.
v
Option
w00 [

Configuration

bedovoraida

Enable Extended Interrupts

Ris W AE3S0 50C

Cancel

8.2.2 Instruction Memory

MUG1031-1.1

HATHF “Instruction Memory”, L E 4817 i #FiLT, sl 8-8 it

7N

Instruction Memory 45 Embedded Instruction Memory #l1 Extended
Instruction Memory. ##i%E# “Embedded Instruction Memory”, I JF 3
Z YN E [ SPI Flash Memory; % i# “Extended Instruction
Memory”, JIFfE ROMAHB 411, HF BiTi& 1 AHB #2382 12
o, BlunfR % “Extended_Memory (BlockRAM)”, #¢il BlockRAM fE
NER TGS -

AGERWITIE RGN AR SPI Flash Memory.
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8.2 IP it

WRTFE “Embedded Instruction Memory”, NI 7] LLEC & Flash
Register R/\W Mode. #n#i%## “Flash Register R'W Mode”, JF/5
Flash 77 /7 25150 APB i 284511, Flash 7 LAME AN, I8 2547 35 i
BB AE, BOAKH.

[%] 8-8 Instruction Memory B &

' Instruction Memaory ? *

Instruction Memory o

embedded memary as instruction memory. ~
Extended Instruction Memory exports all ROM
AHB bus signals for user level memory.

Embedded Instruction Memary is allowed to
S T o access Flash with register mode, this is, users can
' erase, read and write flash as a peripheral.

'

TOO AT

'

Options

Configurations

Instruction Memory Select

I

® Embedded Instruction Memory

e

[ Flash Register R/W Mode

W

Cancel

RseV AE3S0 50C

B ETR ARSI A 5, WA LR LRSI -

R 2 18 = = T KA ) SPI Flash Memory, 163 Embedded
Instruction Memory %&£ .

WA FPGA 2481 BlockRAM, %%+ Extended Instruction
Memory i3, FZHfERTE “Extended_Memory (BlockRAM)”.

U SRAR ) A SRR fif 5%, 156 $F Extended Instruction Memory i%
Wi, FE %I AHB Memory 4% I 776k 282 i 542 1 o

8.2.3 Data Memory

MUG1031-1.1

T “Data Memory”, BCEEiE A itast o, i 8-9 Fris.

Data Memory fi#5 Embedded Data Memory 1 Extended Data
Memory. WIHE%EH “Embedded Data Memory”, TIJTJE 248 N & )
DDR3 Memory; #n%ik# “Extended Data Memory”, IJT 5 DDR AHB
B0, B EAT®E AHB #2520 R gy, BlanfRr &=

“Extended_Memory (BlockRAM)”, it BlockRAM 1 A% A7t 45 -

Z4:8\ “Embedded Data Memory”, JFJ5 & 4i N & ft) DDR3
Memory. 15 H F AR E & ¥ lid B DDR3 Memory Interface IP %%
W, SIS “Extended_Memory (DDR3)”,
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[# 8-9 Data Memory it &

' Data Memory ? *

Data Memory e

SOC is for running MCLU data, including ~
embedded data memory mode and extended
data memory mode.

Embedded data memory is to configure
embedded memary as data memory. Extended
data memory exports all RAM AHB bus signals
for user level memory.

Options

Configurations
Data Memory Select
(® Embedded Data Memory

bbb
S EREEEEEEEE RS

() Extended Data Memory v

B A EHEA SR N R 5, WA LR LRSI -

RS =T R AT F ) DDR3 Memory, i%i%#% Embedded Data
Memory &,

WA FPGA 241 BlockRAM, i%i%# Extended Data Memory
I, SRR TR “Extended_Memory (BlockRAM)”.

iR 45 H DDR3 Memory, {HARLIN 55 5 i 2= TF R AT F I AR, 3
% # Extended Data Memory &5, FHZ k7% “Extended_Memory
(DDR3)”, H¥fic & DDR3 Memory Interface IP )& 4% 1 .

T SRR ] HA 2B A4 2%, 15 1% % Extended Data Memory %7, Jf 5B # %Kit
AHB Memory % [ [ 7 il s 125 il 25 2 1
8.2.4 12C

AT “12C7, BCE “12C”7 %5, & 8-10 o,
® ikt “Enable 12C”, NI/ 12C, BRIAKH]
® IRJTE 12C, WA LR E 12C i 28R

- WRikHF “Enable 12C 1/0 Ports”, NFF/E 12C “INOUT” 2% i
M, BIIFE “IN7, “OUT” KAGH O, Bk “INOUT” i [T
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& 8-10 I12C Bt B

Te12c ? *

12C o

support of hardware handshaking to the DAMC.  ~
The 12C madule is a peripheral of APE bus

interface in AE350 SOC. If users enable 12C, it

W ST o could export 12C signals for user level.

-

- Base address: OxFOAOD0D0D
- End address: OxFOAFFFFF

Option

Configuration

2 504 Enable 12C

SRSVRTY

Interface:

Enable 12C I/O Ports v

Ris €V AE3S0 50C

8.2.5 PIT

XEHFTIF PIT, ECE PIT &0, @k 8-11 Frax.

o 1Rk “Enable PIT”, NIJF/E PIT, ERIAKH

® UIRIF/E PIT, MW LIACE PWM iliE
- kR “PWM Channel 07, JF )5 PWM JEiE 0, BRikCH]
- R EE “PWM Channel 17, MIFFjG PWM il 1, ERAKH
- R ERE “PWM Channel 27, MIFFjg PWM iliiE 2, ERiAEH
- R EE “PWM Channel 3”7, MIFFjg3 PWM i 3, ERiAKH
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8.2.6 SPI

MUG1031-1.1

[ 8-11 PIT B2 B
da PIT 7 X
signals for user level. ~
— W o T o ouT [ - Base address: OxF0400000
— o s T N, - End address: OxFO4FFFFF
- v
Y o
—{ 0o Option
AE =
— 1 :
o Configuration ~
—
ol Sl Enable PIT
——
— b T PWM Channel Select
CHI POWRACHE [
— ] T -
ol e . PWM Channel 0
—] o w3 o [ PWM Channel 1
PWM Channel 2 i
Ris <V AE350 5OC

MAAT I SPI, BELE SPI &,

E 8-12 Ak .

® NHiEkHE “Enable SPI”, NJT/E SPI, BRi\EH.
® R JF)E SPI, N LAACE SPI b 11285

- WHRiEFE “Enable SPI /O Ports”, MIF)E SPI “INOUT” 5/ i
H, BN E “IN7, “OUT”, “OE” KA, Bk “INOUT”

iy 11 8 7Y

8-12 SP1 it &

< SPI

SPI

2

LS A

S 2 B B R

Ris W AE350 50C

quad 1/O modes.

The 5Pl maodule is a peripheral of APE bus
interface in AE350 SOC. If users enable SPI, it

could expaort SPI signals for user level.

- Base address: 0xFOF00000
- End address: OxFOFFFFFF

L]

Option

Configuration

Enable SPI
Interface:

Enable SPI I/Q Ports

Cancel
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8.2.7 UART1 #1 UART?2

iy “UART1” B “UART2”, BCE “UART1” B “UART2” &L,
i 8-13 Fk.

® Hi%EFE “Enable UART1”, MJT/E UART1, ERIAKH.
® Hi%EFE “Enable UART2”, MJT/5 UART2, ERIAKH.
8-13 UART1 #1 UART2 it &

' UART ? *

UART TS

The UART module is a peripheral of APB bus
interface in AE350 SOC. If users enable UART1 or
UART2, it could export UART1 or UART2 signals

for user level.

-
3 ™
o afe UART1 UARTZ
] . - Base address: 0xF0200000 OxFO300000
1 e - End address: OwFO2FFFFF OxFO3FFFFF. v
— "
el o .
i B Options
e : Configuration
2 e Enable UART
2 - Enable UART2
W

Bimcls' AF 350 200

8.2.8 GPIO

MEFTH GPIO, BiE GPIO i, tnf& 8-14 frx.
® Uflik$E “Enable GPIO”, NIJT/E GPIO, ERI\KHI.
® HJTE GPIO, WIFLLNCE GPIO i 1 257Y.

~ fmEi%$E “Enable GPIO I/0 Ports”, NIFFiE GPIO “INOUT” 27
B, BUFFRE “IN7, “OUT”. “OE” KA1, BRIk
“INOUT” 3 127
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829 WDT

8.2.10 RTC

MUG1031-1.1

& 8-14 GPIO EL &
d GPIO 7 s
de-bounce functionality for input channels. ~
The GPIO module is a peripheral of APB bus
I o T interface in AE350 SOC. If users enable GPIO, it
— o e T could export GPIO signals for user level.
) - Base address: 0xFO700000
—l 10
) - End address: OxFO7FFFFF
— A b
b el Cption
— e
. A
e Configuration
—| T GRCHIL (-
Enable GPIO
— TEST_%
I Interface:
Enable GPIO IO Ports ]
Ris £V AE350 SOC
X7 WDT, ECE WDT &, ik 8-15 Frow.
Ak “Enable WDT”, WIFF/E WDT, ERIAKH
[ 8-15 WDT it &
b WDT ? X

WDT

2

LS A

Ris W AE350 50C

watchdog timer reaches zero. The timer should &
be restarted in the watchdaog interrupt service
routine.

The WDT module is a peripheral of APB bus
interface in AE350 SOC.

- Base address: OxFOS00000
- End address: OxFOSFFFFF

Option

Configuration

[~] Enable WDT

Cancel

WiEHTH RTC, BLE RTC i&EWi, 1A 8-16 fixs.
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BRI JE RTC, ANA] L],
[ 8-16 RTC Et &

e RTC 7 *

RTC e

The RTC includes separate second/hour/day
counters, periodic interrupts, and programmable

Configuration

Enable RTC

I PO T alarm interrupt with specified second/minute/f

— e ST hour values.

— i o L The RTC module is a peripheral of APB bus
interface in AE350 SOC.

= Loa O o CUT =i

e - Base address: OxFOG00000

— 2 0 - End address: 0xFOBFFFFF v

e Option

—in

-

-

—»{

Ris W AE350 50C

8.2.11 SMU

KT SMU, BCE SMU %50, K 8-17 Fix.
W% “Enable SMU”, NJF/E SMU, ZRi\%H] .
[ 8-17 SMU E2&

T SMU ? *

SMU o

of Risc¥ AE350 S50C controls the flow of power  ~
and clock changes.
B R The SMU module is a peripheral of APB bus
s . interface in AE350 SOC. If users enable SMU, it
pa]s
—l o could export SMU signals for user level.
—
. - Base address: 0xF0100000
B e ’ - End address: OxFO1FFFFF
= L
i R CEREY WA _MODE i Dption
i TR
—e| TS 5 .
e e | Configuration
i THEST
o Enable SMU
RiseV AE3S0 50C
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8.2.12 DMAC

Md7 4T DMAC, [ & DMAC i, 4/ 8-18 flix.

A& “Enable Extended DMAC”, MIFFEH J& 1] 8 41 DMA 183K/
REAE S, BRIAKH.
8-18 DMAC ft &

"o DMAC ? b4

DMAC &

between devices in background to offload the "
processor.

The DMAC supports up to 8 extended DMA
channels and up to 16 DMA request/
o 1 — acknowledge pairs for hardware handshake.
. If users enable the extended DMAC, it could
export B extended DMA requestfacknowledge
pairs for user level.

Option

Configuration

NERRSNERERY
'

Enable Extended DMAC

Ris W AE3S0 50C

8.2.13 Extended APB Slave

M7 T Extended APB Slave, [t & Extended APB Slave i£1j, 0
@ 8'1 9 ﬁﬁﬂ—‘_\‘o

MR EFE “Enable Extended APB Slave”, NFF a4 &K 32-bit APB
Slave #1171, ZRiAKH .

it Extended APB Slave, 1] LLi%#: FPGA #4E4 RSt APB A
AN, BlanfE s %€ “Extended_APB_Slave”.
“Extended  APB2APBBridge ”. “Extended_APB_Flash”,

MUG1031-1.1 36(48)




8 TEAN Bt T5 ik 8.2 IP #il

[E 8-19 Extended APB Slave BL B

' Extended APB Slave ? *
R
Extended APB Slave 37
~
. - Base address: 0xFB000000
- ma AT [ - End address: OxFEBFFFFFF
=i s T .
Too 08 - Size: 64MB
— o w
= oo SORALD =
= A FEMASLE pfite Option
= L EEL
— — Configuration
— T
I —- Enable Extended APB Slave
— ST
e TSI e
— AOATA
2 O~
— AP READY
e s LR ™
RiseW AE 350 50C

8.2.14 Extended AHB Slave

Xt 4THF Extended AHB Slave, [t & Extended AHB Slave i&3, N
@ 8'20 Fﬁ)j_io

%k “Enable Extended AHB Slave”, MFE4 &1 32-bit AHB
Slave #17, ZRiAKH.

ik Extended AHB Slave, 7] LLi%$: FPGA 254 LIl ) AHB &
R ORANE, Blanfie iR “Extended AHB_Slave”.
“Extended_AHB2AHBBridge ”. “Extended_AHB_Ethernet”.
“Extended_AHB_CAN”.
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[E 8-20 Extended AHB Slave fit &

" Extended AHB Slave ? >

Extended AHB Slave o

as slave to extend the user peripherals of AHB ~
N I bus interface.
N — i If users enable the Extended AHB Slave, it
S T e could export AHB slave bus signals for user level.
) CATS MAC CDRET 1 e
— s 0oR CLE
—olaar e - Base address: 0xES000000
N - S - End address: OxEFFFFFFF
—mfrr o o - Size: 128ME
— T W TS MQITT e hd
e bl DTS TR AT 1 [ Option
e
CHETS MWDATALD |0 i
— T .
S AT AT [ Configuration
- EaTy TS CL =
T Enable Extended AHE Slave
P — LTS (ST [l
RescV B 250 SO0

8.2.15 Extended AHB Master

X7 Extended AHB Master, fit & Extended AHB Master %&£,
ﬁﬂ@ 8'21 Fﬁﬂ—_‘—\‘o

Rk “Enable Extended AHB Master”, NH 54 & 1Y 64-bit AHB
Master 211, ERIARMA .

8-21 Extended AHB Master Bt &

' Extended AHB Master ? *

Extended AHB Master T

The Extended AHB Master module of RiscV
::’:“ AE350 SOC is a standard AHB bus interface. RiscV
N - o AE350 S0OC is as slave, user level side is as master.
- =T If users enable Extended AHB Master, it could
:: export AHB master bus signals for user level.
—|-r~ @ |-
=
™ T 11—
Option
BN AT

Configuration

R

Enable Extended AHB Master

i#id It AHB Master #2110, AE350 24in] LIME N Slave, FPGA &4:1]
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PIME N Master, FPGA £4i1)jin] AE350 24t A 1 ILM A1 DLM, M &
T FPGA RS K125 ]

8.3 APt

8.3.1 RiscV_AE350_SOC IP it

IR R IP %21t T H “IP Core Generator”, 58/,
RiscV_AE350_SOC IP [t &5, H.ii “OK”, /%4 RiscV_AE350_SOC IP
wit, K 8-22 fs.

[ 8-22 RiscV_AE350 SOC IP &3t

(& RiscV AE350 SOC ? X

General

Device: |GW5AST-138 ‘ Device Version: |B |
Part Number: [GWSAST-LV138FPG676AES |

Create In: |C:\Users\liukai\Desktop\aeSSO_demo\src\riscv_aeSSO_soc |
File Name: riscv_ae350_soc Module Name: |RiscV_AE350 SOC Top
Language: Verilog -

AE350 Subsystem

I 1 [ 1

8.3.2 PLL_ADV IP &3t

AR IP %3t T B “IP Core Generator”, Fi & PLL_ADV IP i%
5, 74 PLL_ADV IP i, J9 RiscV_AE350 _SOC IP {ALif iz i .

E IR ARk “Tools > IP Core Generator”, 8¢ T. 4%
“d8”, 4Tt IP Core Generator, %+ “Hard Module > CLOCK >
PLL_ADV 1.0”7, %% 4-1 f1% 4-2 it & PLL_ADV IP, % PLL_ADV
IP & it, &l 8-23 fw.

. AT RiscV_AE350 SOC W1 PLL_ADV IP:
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8.3 /it

® ClkoutO: DDR clock
® Clkout1: CORE clock
® Clkout2: AHB clock
® Clkout3: APB clock
® Clkout4: RTC clock
FI T RiscV_AE350_SOC DDR3 Memory [f] PLL_ADV IP:
® Clkout0: DDR3 input clock
® Clkout2: DDR3 memory clock
& 8-23 PLL_ADV IP i&it
5 IP Customization 7 X
PLL oo
General
Device: [awsasT-138 | Deviee version: |8 |
Part Number: | GWSAST-LV1 38FPGG7GAES | tanguage: Verilog -
File Name: | gowin_pll | Module Name: [ Gowin_PLL |
Createln:  Ci\Users\liukai\Desktop\gwSast\ae350_demo\src\gowin_pll
ol oLy | Commen Clkoutd  Clkout!  Clkout2  Clkoutd  Clkoutd  ClkoutS  Clkouts  Clkfbout
— | enci e CLKIN PLL Reset "
s el Clock Frequency(10~400): PLL Reset
S - L Divider Factor [] PLL Power Down
J p— : Static |1 [] CLKIN Divider Reset
— T [ CLKOUT Divider Reset
ele VCO Frequency:
T enchs : CLKFB Lock
I ench ang Source: @ Internal External Enable Lock
e i - Divider Factor
Static |1
ICP and LPF Optional Ports
ICPSEL $5C
5 P Clock Enable Ports
Cancel | | Calculate

8.3.3 A&t

MUG1031-1.1

RiscV_AE350_SOC (NI 4 H “PLL_R[0] > clkout1” ELiEHR4t,

PLL_ADV IP ] “clkout1” /=4 i 4.

2 H

RiscV_AE350_SOC f#) DDR3 Memory i 8l H “PLL_L[0] > clkout2” ELZ4EfE, HiX
f§iF] PLL_ADV IP f] “clkout2” 7*/: DDR3 Memory i} 4f,

BT E R b, szl RiscV_AE350 _SOC IP, szt
PLL_ADV IP, JIAFABF P88, R S gl il e B i 1351t
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8.4 AR

8.4.1 YIBLAER
SIRFTFFERAR, IONPIELIR, AT L 2R R 4 ok T 2

“FloorPlanner”.

%27 i DK-START-GW5AT138 V2.0 DVK Board 5 Andes
AICE-MINI+] JTAG £ HH MR T, W3k 8-1 fis.

% 8-1 &M JTAG PR (Andes AICE-MINI+)

MUG1031-1.1

JTAG #:11 DVK Board Andes AICE-MINI+
GND J3-8 P3

TMS J3-3 P4

TCK J3-4 P6

VREF (3.3V) J3-7 P7

TRST J3-5 P10

TDO J3-6 P11

TDI J60-3 P12

#1127 %11 DK-START-GW5AT 138 V2.0 DVK Board 5 Gowin
Cable ] JTAG % I HIX MIERETT 30, 413 8-2 fr.

& 8-2 BEGIHH JTAG ¥IFBLR (Gowin Cable)

JTAG #:M DVK Board Gowin Cable
GND J3-8 P2
TMS J3-3 P9
TCK J3-4 P1
VREF (3.3V) J3-7 P6
TDO J3-6 P5
TDI J60-3 P3

#1127 ¥% it DK-START-GW5AT138 V2.0 DVK Board 5 Olimex
Cable /1 JTAG £ H X MIERE T30, a1k 8-3 .

%< 8-3 SE I JTAG 49 £)3R (Olimex Cable)

JTAG #:1

DVK Board

Olimex Cable

GND

J3-8

P4
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8.4 4K

JTAG £ 11 DVK Board Olimex Cable

TMS J3-3 P7

TCK J3-4 P9

VREF (3.3V) J3-7 P1

TRST J3-5 P3

TDO J3-6 P13

TDI J60-3 P5

® RiscV_AE350_SOC HM kI H “PLL_R[0] > clkout1” EE#At, NALHRIL
PLL_ADV IP fif2 B4 “PLL_R[0]”. %11, INS_LOC
"u_Gowin_PLL_AE350/PLL_inst" PLL_R[0].

® RiscV_AE350_SOC ) DDR3 Memory 4l “PLL_L[0] > clkout2” ELJEHRML, il
29k PLL_ADV IP A2 & N “PLL_L[0]”. 140, INS_LOC
"u_Gowin_PLL_DDR3/PLL_inst" PLL_L[0]

8.4.2 BTRF4R

MUG1031-1.1

ZIATI o el NN FRZ00R, /] DS = P AT I e 24071
T.H “Timing Constraints Editor”.

BARI R iR es . “Place & Route > Timing Analysis Report”,  11[&]
8-24 FIi7R .

8-24 Timing Analysis Report

{# GOWIN FRGA Designer - [C:\Users\|iukai\Desktop\ae350_demo\imph\pnr\ae350_demo.trhiml] - [m] X
7 Hle Edit Project Tools Window Help -8 x
EEEE Z& M- EHE @

2 -
NUMDErs O SETup VIGIArea Enapoines | U
Process J X

! | Gesigns Timing Messages Numbers of Hold Violated Endpoints | 0
esign Summary . .

v R User . » Timing Summaries
 User Constraints Clock Summary:

[ ccome e peronrreencyouis) |

[Z£ Floorplanner STA Tool Run Summary

P Timing Constraints Editor Clock Summary

v (D synthesize Max Frequency Summary pll_clkout2 Base 20.000 | 50.000 C
Synthesis Report Total Negative Slack Summary CLK Base 20.000 | 50.000 f

Netlist File + Timing Details u_RiscV_AE350_SOC_Top/FLASH_SPI_CLK_iobuf/I Base 10.000 | 100.000 «

- Q Place & Route » Path Slacks Table u_RiscV_AE350_SOC_Top/FLASH_SPI_CLK_in Base 10.000 | 100.000 (
u_Gowin_PLL/PLL_inst/CLKOUTO.default_gen_clk  Generated 20.000 @ 50.000 (

= PTﬁc‘e & Rcu‘e. Feport Setup Paths Table u_Gowin_PLL/PLL_inst/CLKOUT1.default_gen_clk | Generated | 1.250 800.000 (

E| Timing Arfﬂ‘y“ g Hold Paths Table u_Gowin_PLL/PLL_inst/CLKOUT3.default_gen_ck | Generated 20.000 | 50.000 (

Ports & Pins Report Recovery Paths Table u_Gowin_PLL/PLL_inst/CLKOUT4.default_gen_clk | Generated | 100.000  10.000 «

1
vl Program Device Removal Paths Table

Minimum Pulse Width Table Max Frequency Summary:

:
<

Qetun Analvsic Ranart b Al Alr S0 AANMMEEY | 5n n7aimdsy | 1a
>

< >

Design  Process  Hierarchy y Start Page Design Summary ae350_demo.trhtml [x]

Console & x
[95%] Timing analysis completed ~

Placement and routing completed

Bitstream generation in progress......

Bitstream generation completed

Generate file "(:\llsers\liukai\Deskton\ae35@ demo)\imnl\nnriaei5@ demo_nin_html" comnleted
<

%

Console  Message
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8.5 &

8.5 I &

8.5.1 {FHIEIN

“Synthesize > General” Zi & WACE, 1 8-25 Frax. -

® SRR TSR R A FK, BLE Top Module/Entity

o ZHRAIMF B S PRk SO 5 842, ECE Include Path
® \Verilog Language FC &, flun System Verilog 2017

& 8-25 Z /XA E

W Configuration

v Global
General
Voltage

v Synthesize
General

~ Place & Route
General
Place
Route
Dual-Purpose Pin
Unused Pin

“ BitStream
General
sysContral

Feature sysControl

Synthesize

General

Synthesis Tool: @ GowinSynthesis

Top Module/Entity: |aeSSD_demo_top

Include Path: |

TelPre |

GowinSynthesis

Verilog Language: | System Verilog 2017 ~

Looplimit: 2000 =
[] Show All Warnings

[] Disable Insert Pad

[] Ram R/W Check

Cancel

Apply

8.5.2 TR LkIEM

A JR AT £k & Tl & B 45 General. Place. Route. Dual-Purpose Pin I
Unused Pin, 1K 8-26 Fizs.

MUG1031-1.1

S IR SEBR 7 >R BC &, 4140 Dual-Purpose Pin %,

“SSPI”, “MSPI” #1 “CPU” K 10,

2H
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[ 8-26 15 B I &

W Configuration *

Dual-Purpose Pin

v
Global [] Use ITAG as regular IO
General
Voltage Use SSPI as regular 10
v Synthesize Use MSPI as regular 10
General [] Use READY as regular 10

v Place & Route [] Use DONE as regular 10

General
[] Use RECONFIG_N as regular 10
Place

Route Use 12C as regular 10
Dual-Purpose Pin Use CPU as regular 10
Unused Pin

~ BitStream
General
sysControl

Feature sysControl

Cancel Apply

8.5.3 MifixIn

fidh i 1% T AC B 4% General. sysControl £ Feature sysControl, #1/&
8'27 ﬁﬁ}j_‘—\‘o

& 8-27 IBiRETEL B

W Configuration =
BitStream
v
Global Enable CRC Check
General
Voltage [] Enable Compress
v Synthesize [] Enable Encryption
General Key(Hex): |00000000-00000000-00000000-00000000
v Place & Route Enable Security Bit
General
Secure Mode
Place
Route Power On Reset Monitor
Dual-Purpose Pin Print BSRAM Initial Value
Unused Pin

Bitstream Format: | Text  ~
v BitStream

General
sysContral

Feature sysContral

8.6 L&

=R BAE %44 T B “GowinSynthesis®”, 4:4 RiscV_AE350 _SOC
fEfEeTl, PR AEMR SO, & 8-28 Fi.
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8.7 ARtk

& 8-28 424

GOWIN FPGA Designer - [CAUsers\liukai\Desktop 50_demo_syn.rpthtml] u}
| Ele Edit Project Jools Window Help - &%
v 5
U [EE) 7 |: & 3 Ee «
e o % Synthesis Details
1 | Design summary i
R - Synthesis Messages Top Level Module 2e350_demo_top
~ [J° User Constraints — -
77 Floorp! = Synthesis Details Running parser:
t=8 FloarFlanner R CPU time = Oh Om 13, Elapsed time = 0h Om 1s,
£ Timing Constraints Editar o Resource Peak memory usage ~ 100.953MB
Running netlist conversion:
v Synthesize > Resource Usage Summary CPU time = Oh Om 0s, Elapsed time = 0h Om 0,
e Peak memory usage = OMB
Synthesis Report ° Resource Utilization Summary Running device independent optimization:
. Timing Optimizing Phase 0: CPU time = 0h Om 0.031s,
Netlist File Elapsed time = Oh Om 0.048s, Peak memory usage =
o Clock Summar 100.953M8
v Place & Route v Optimizing Phase 1: CPU time = Oh Om 0.046s,
Place & Route Repart o Max Frequency Summary E‘;ﬂgéﬂ%ﬂgﬂe = 0h 0m 0.023s, Peak memory usage =
. ysi = Detail Timing Paths Informations Optimizing Phase 2: CPU time = Oh Om 0.031s,
Timing Analysis Report Elapsed time = Oh Om 0.028s, Peak memory usage =
Ports & Pins Report 100.953M8
Running inference
IE Program Device Inferring Phase 0: CPU time = Oh Om 0.046s,
o Elapsed time = Oh Om 0.054s, Peak memory usage =
100.953MB
Inferring Phase 1: CPU time = Oh Om Os, Elapsed
time = 0h Om Os, Peak memory usage = 100.953MB
Inferring Phase 2: CPU time = 0h Om 0.015s,
Synthesis Process Elapsed time = Oh Om 0.007s, Peak memory usage =
<
Design  Process  Hierarchy ; Start Page Design Summary J  ae350_demo_synrpthtml [
Console
[95%] Timing analysis completed
Placement and routing completed
Bitstream generation in progress..
Bitstream generation completed
Generata file "C:\llsers\linkai\Nasktonlaa3Sh demntimnl\nnriaa3S@ demo. nin.html” comnlated
< >
%
Console  Message

8.7 TiEafht

MUG1031-1.1

VR AT R AT 2k TR “Place & Route”, i Jaj Al 4 W % A,

i scft, dnlsl 8-29 Frar.

& 8-29 G Thk

g

 Fle Edit Project Tools Window Help
[
Process F X

1| Design Summary
v [} User Constraints
[24 FloorPlanner
/% Timing Constraints Editor
v () synthesize
Synthesis Report
Netlist File
v (D Place & Route
~ Place & Route Report
Timing Analysis Report
Ports & Pins Report

- )
)
1% program Device

{4 GOWIN FPGA Designer - [C:\Users\liukai\Desktop\ae350_dema\impl\pnriae350_demo.rpthtmi]

PnR Details "

- PnR Messages
« PnR Details
- Resource

¢ Resource Usage Summary
Place & Route Process
- I/0 Bank Usage Summary

Global Clock Usage Summary
Global Clock Signals

Pinout by Pport Name

All Package HAital Time and Memory Usage

2 -

Running placement:
Placement Phase 0: CPU time = 0h Om 0.363s, Elapsed time = 0h Om 0.363s
Placement Phase 1: CPU time = 0h Om 0.191s, Elapsed time = 0h Om 0.19s
Placement Phase 2: CPU time = 0Oh Om 0.161s, Elapsed time = 0h Om 0.162s
Placement Phase 3: CPU time = 0h Om 1s, Elapsed time = 0h Om 1s
Total Placement: CPU time = Oh Om 2s, Elapsed time = 0h Om 2s

Running routing:
Routing Phase 0: CPU time = Oh Om 0.588s, Elapsed time = 0h Om 0.588s
Routing Phase PU tim 0h Om 6&s, Elapsed time = Oh Om 65
Routing Phase 2: CPU time = Oh Om 0.43s, Elapsed time = 0h Om 0.43s
Routing Phase 3: CPU time = Oh Om 0s, Elapsed time = Oh Om 0s
Total Routing: CPU time = Oh Om 75, Elapsed time = Oh Om 7s

Generate output files:
CPU time = 0h Om 18s, Elapsed time = Oh Om 18s

CPU time = 0h Om 275, Elapsed time = 0h Om 275, Peak memory usage = 972MB

Resource
[ VAR ) DI F S v
< >
Design  Process  Hierarchy ? Start Page Design Summary 7 ae350_demo.rpthtml @
Console 8 x
- " = P = P o -
Generate file "C:\Users\liukai\Desktop\ae350_demo\impl\pnriae35@_demo.rpt.html” completed
Generate file "C:\Users\liukai\Desktop\ae35@ demo\impl\pnriae35@_ demo.rpt.txt" completed
Generate file "C:\Users\liukai\Desktop\ae35@ demo\impl\pnri\ae35@_ demo.tr.html" completed
Mon May 22 11:31:06 2023 P
< >
%
Console ~ Message
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8.8 T&;

IRBAR T ECC A “Programmer”, N #053 SCAF.

=R AE, “Process > Program Device”, i3 :3ZH#. “Tools >
Programmer”, B¢ T H A2 “I48”, $TH Programmer.

1% $¢ Programmer 32 ¥ “Edit > Configure Device”, =T HA*
AT, A N EOEIT, & 8-30 Fras.

“Access Mode” THi%|#, iE$F “External Flash Mode 5AT”,

“Operation” THi%&, & “exFlash Erase, Program 5AT” &%
“exFlash Erase, Program, Verify 5AT”.

“Programming Options > File name” &3, I AR SCAES
“External Flash Options > Device” &1, #%# “Generic Flash”.

“External Flash Options > Start Address” &1, &N
“0x0000007,

M “Save”, SERN FEGETIACE .
8-30 THIEINALE

i Device configuration ? *

Device Operation
focess Mode: External Flash Mode BAT -

Operation: exFlash Eraze, Program GAT -

exFlazh Eraze, Frogram BAT

Frogramming Options

File name: |fUsers/liukai /Tesktop/2e360_demo/impl /prr/ae360_demo. Es| I .. |

Uzer Flash Initialization

External Flash Options

Device: Generie Flash -

Start Address: 0000000

Sare Cancel

SERC N BGATI B )5, Sl TR “587, TNERGRSCH, Ak 8-31
I
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8.8 T#

MUG1031-1.1

& 8-31 MW

¥ Gowin Programmer Version - [m] >
File Edit Tools About
ST | 5|15 | USB Cable Setting

Enable Series Device Operation FS File User Code IDC
1 GWSAST GWSAST-138B  exFlash Erase,Program SAT ..isc_v/2e350_soc/ref_design/1.1/FPGA_RefDesign/ 0x00003083 000108
< >
futput J X
o TETgET CADTE: GUWITT USD CaIEr T 20 MF07s 17 /Ui T IV, .
Info Target Device: GWSAST-138B(0x00010818)
Info Operation "exFlash Erase,Program 3AT" for device#1...
Info Read Status: 0x00020638
Info Try to program spi flash: 0xC84018C8!
Info Programmning Flash starts from 0x0.
Info Program sFlash finished.
Info The device is reloading, please check later...
Info Cost 70.43 second(s)

v

Ready
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9%%‘1‘&%

Gowin RiscV_AE350_SOC # (Rl 1F 1) 5% Uit

...\ref_design\FPGA_RefDesign\DK_START_GWS5AT138_V2.0\ae350
_demo

...\ref_design\FPGA_RefDesign\DK_START_GWS5AT138 V2.1\ae350
_demo

...\ref_design\FPGA_RefDesign\Tang_ MEGA_138K_Pro_Dock\ae350
_demo

...\solution\Extended AHB_Ethernet\ref design\FPGA _RefDesign\Tan
g_MEGA 138K _Pro _Dock\ae350 ext_ethernet

...\solution\Extended  AHB_CAN\ref_design\FPGA RefDesign\DK_ST
ART_GW5AT138 V2.0\ae350_ext_can

...\solution\Extended_AHB_Slave\ref design\FPGA RefDesign\DK_S
TART_GW5AT138_V2.0\ae350_ext_ahb_slave

...\solution\Extended  AHB2AHBBridge\ref _design\FPGA _RefDesign\
DK_START_GWA5AT138_V2.0\ahb_to_ahb_16_bridge

...\solution\Extended_APB_Flash\ref design\FPGA _ RefDesign\DK_S
TART_GW5AT138_V2.0\ae350_ext_flash

...\solution\Extended_APB_Slave\ref _design\FPGA_RefDesign\DK_S
TART_GWS5AT138 V2.0\ae350 ext_apb_slave

...\solution\Extended APB2APBBridge\ref _design\FPGA_RefDesign\
DK_START_GWA5AT138_V2.0\apb_to_apb_16_bridge

...\solution\Extended_Interrupts\ref _design\FPGA_RefDesign\DK_STA
RT_GW5AT138_V2.0\ae350_ext_intr

...\solution\Extended_Memory(BlockRAM)\ref_design\FPGA_RefDesi
gn\DK_START_GW5AT138_V2.0\ae350_ext_memory(blockram)

...\solution\Extended_Memory(DDR3)\ref_design\FPGA_RefDesign\D
K_START_GW5AT138_V2.0\ae350_ext_memory(ddr3)
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